
 

4th Street Computer Baseball Edition 

Thank you for purchasing the Helper edition of 4th Street Baseball!   

This instruction manual was designed to assist with using the computer program, 

rather than an explanation of how the 4th Street Baseball game operates.  To learn 

more about the mechanics and play of 4th Street Baseball, the board game, please 

visit the 4th Street Baseball board game page at 

http://www.4thstreetsoftware.com/prod04.htm.  The page includes links to the 

complete instruction manual and a downloadable sample of the game. 

Installation 

4th Street Computer Baseball edition, can be installed either by downloading it 

from the web (http://www.4thstreetsoftware.com/prod03.htm) or via CD-ROM.  

The game comes complete with one sample season to get you started.  The game 

will work in Windows 7 SP-1 or later, and requires 4 GB of RAM, and 1 GB 

(minimum) of hard drive space (mostly for game stats files).  The installation also 

requires Microsoft .Net 4.5, which will be automatically installed. 

In either delivery system, simply follow the on-screen instructions to complete 

the installation process.  The default installation folder is  

C:\Program Files(x86)\4th Street Software\4th Street Baseball. 

Starting the Program 

To start using the program, click Start > Program Files > 4th Street Software > 4th 

Street Baseball. 

http://www.4thstreetsoftware.com/prod04.htm
http://www.4thstreetsoftware.com/prod03.htm


The program will load, but you will need to open a season file in order to actually 

use the program.  This is done similarly to opening a word processing file…click 

the Open File tool on the toolbar, navigate to the season folder you wish to work 

with, and select the season file, which has the file extension “.X4BB” 

 

 

 

 

 

 

 

 

 

 

 

In the example above, the user opens the “1960” folder and then double-clicks on 

the “BBTM1960HELPER2.X4BB” file.  After checking if some files need updating, 

the program will populate the screen with data for the season. 

  



Checking for Updates 

Periodically, updates are released for the program.  It is important that you check 

for updates regularly, as continually using an older edition of the game may make 

your game stat file incompatible with future releases. 

To check for updates, you have two options: 

 Select “Check Web for Updates” from the “Help” menu (may not work with 

some system set-ups) 

 Visit the 4th Street Computer Baseball support page at 

http://www.4thstreetsoftware.com/serv03.htm, and check to see if your 

version of the game is the same as the update posted. 

The program itself will not check for updates automatically. 

  

http://www.4thstreetsoftware.com/serv03.htm


The Home Screen 

The Home Screen helps direct traffic to all of the other options available with 4th 

Street Computer Baseball edition. 

 

The program version can be viewed from the very top of the screen, or by 

selecting “About” from the “Help” menu. 

Options for this program are available either from the menu or the toolbar at the 

top of the screen.  Descriptions of each option follow. 

  



Team Management 

The Team Management (or “Draft”) screen enables you to change rosters, 

activate or deactivate players, and make trades. 

The left-hand portion of the screen displays all players who made it into a game 

during the season you are working with (although some of those players may 

have some rather odd ratings due to their small sample of work).  Those who are 

not available (that is, they have already been assigned to a team) have an 

“unavailable arrow” in front of their name. 

 

The right-hand side of the screen displays the selected team’s roster, with active 

players flagged with a check mark.  The team’s total for each position are listed 

below the roster.  You may display only the names of a certain position type by 

pressing the appropriate button (e.g., “IF” for infielders) above the total. 

To add a player to a team, click his name in the player list, then click the “Add” 

button (or, you can double-click on his name in the player list).  To remove a 

player from a team, click his name in the team roster and click the “Remove” 

button. 



There are several draft options from the “Draft” menu, including: 

 Auto-Draft One Player.  As its name implies, this option selects one player 

for the current team. 

 Auto-Draft to Fill Rosters.  Select the number of rounds you wish to 

complete, and whether to conduct the draft in a “Serpentine” (first team to 

select in round 1 will be the last to select in round 2) manner by choosing 

the appropriate options at the bottom of the screen. 

 Automatically Place Players on Original Teams.  This option releases all of 

the players from each team, and then reassigns them to their original big 

league teams.  If you have created a new organization and are using 

fictitious teams, this is not an option you’ll want to employ. 

 Release All Players from All Teams.  Does exactly what it says it will. 

 Release All Players from This Team.  Does exactly what it says it will. 

  



Rotation Editor 

This screen allows you to set up a team’s pitching rotation and bullpen roles.  

Select a player from the team roster, then click the appropriate button to mark 

that player’s role on the pitching staff. 

 

  



Lineups 

The lineup screen enables you to review, modify, and create lineups for a team. 

A dropdown list of previously-created lineups is located above the team roster, 

allowing you to create up to 10 lineups for each team in an organization.   

Unlike the Rotation screen, lineups are not automatically saved.  After you make a 

changes to a lineup, be sure to click the “Save” button on the toolbar. 

 

Players in the team roster are color-coded by position, and players already in the 

current lineup receive an “unavailable arrow” to help prevent you from placing 

them in two different lineup or fielding positions. 

As you make changes to the fielding positions, you’ll see those changes reflected 

on the baseball field on the right side of the screen. 

  



Stats 

The Stats module allows the viewing, editing, and compiling of game statistics.  

There are a number of options available, including: 

 Open Game Stat File.  This option allows you to open the stats file for 

a previously played game, whether it has been completed, compiled, or still 

in progress.  You can change the type of file to open in the open file dialog 

box that displays when you press this button.  Each type of file has its own 

distinct file extension: 

o “.XGC” are files that represent games already completed and 

compiled 

o “.XGS” are files from games that were completed but not yet 

compiled 

o “.XGM” are files from games that have been started, but not yet 

completed nor compiled. 

 Print Preview.  This option lets you see what a printout will look like 

before you actually print it. 

 Print.  Will print the current display. 

 Compile and Compile All.  These options will compile “.XGS” files 

(game stat files from previously completed, but not compiled, games).  The 

first option compiles only the file (if any) that is currently open.  The latter 

compiles all played but not yet compiled games on the organization’s 

schedule. 

 Box Score.  Displays the box score for a loaded game file, no matter 

what its status. 

 Game Log.  Displays a type of play-by-play account of the game. 



 Season Stats.  Displays the season stats for the selected team. 

 Standings.  Displays the season standings for the organization. 

 League Leaders, Team.  Displays hitting, pitching, and fielding 

league leaders for the organization loaded. 

 League Leaders, Individual.  Displays hitting, pitching, and fielding 

league leaders for the organization loaded. 

 Hitting Editor, Pitching Editor, Fielding Editor.  These tabs let you select a 

player on the current team from a dropdown list and make changes and 

corrections to his stats line.  It’s a great tool for leagues using a 

combination of computer play and board play, or just board play. 

 

The “File” menu also includes an option to open, save, and close a “Cascading 

Style Sheet” (.CSS) file that controls how your stats displays look.  You can add to 

or modify the style sheet at your leisure, although it is not recommended that you 

delete any of the default tags, as this could cause your program to behave 

unexpectedly. 



 

The “Reset” menu item will reset all player and team stats to zero, gives the 

option to reset the schedule, and rest all of the players automatically. 

  



Ballpark and Weather Editor 

The Ballpark and Weather Editor let you design, modify, and “build” ballparks to 

practically any specification you want. 

Ballpark effects pop up a few times in almost every game.  Building a team to take 

advantage of your park is one of the most important aspects of being a general 

manager. 

 

As per the board game edition of 4th Street Baseball, an average fence distance is 

set at 15.  Changing the depth of the fences will determine the difficulty of hitting 

homeruns.  This can be modified by changing the numeric up-down controls 

below the field.  Because of the complexity of the redraw code, please note that 

the ballpark picture will not be updated until you click on either the “Save” button 

on the toolbar, or click the “Re-Draw” button at the bottom-right of the screen. 

Each ballpark is comprised of 15 lanes, lettered from “A” to “O,” and 20 depths, 

numbered from 1 to 20.  In two areas…one for outfield, one for infield…some 

depths have been compressed.  This simulates fielders being positioned at 

“regular depth” during a ball game. 



The fence height can also be modified.  Actual height from approximately 1-14 

feet have been given a fence height of “1,” while actual heights from 15-24 have 

been given a height of “2,” etc.  These are not hard-set standards, as the 

propensity of a ballpark surrendering homeruns has also been taken into account. 

The “Shade” controls dictate how frequently balls hitting the fence bounce back 

to an outfielder, thereby changing the result from a normal double to a single.  

Shaded areas are typically located in lanes “D,” “H,” and “L,” which is the normal 

positioning lanes of the outfielders, and depths 15 or less. 

For aesthetic purposes, fence distances may be drawn onto (or close to) the 

fence, and the color of the fence can be changed from the toolbar.  The default 

color of all fences is black. 

Weather effects can also be incorporated into the game.  Climate information can 

be imported for a number of locations in North American from the “Import 

Weather by City” dropdown on the toolbar.  Average high and low temperatures, 

average rainfall (in inches times 100), and average wind speed can be set by 

month near the bottom-right of the screen. 

You can also dictate whether a stadium is open air (subject to ALL weather 

effects), retractable (subject only to wind), or domed (subject to no weather 

effects). 

You can name your stadium by typing it below the team name on the top-right of 

the screen.  Stadiums in 4th Street Baseball are rarely named, as we choose not to 

get caught up in the advertising ploys of professional sports. 

If you have created a new organization, be sure to generate stadiums for all teams 

by clicking the “Transfer” button on the toolbar ( ).  Each team in your league 

will have a picture file generated for its stadium, based upon the fence data that 

has been input.  The picture files are stored in a “Stadiums” folder inside the 

season folder (e.g. “1960”) for which you are working, and are used during game 

play. 



Settings 

The Settings screen is a place you might want to start with, as this is where you 

set roster sizes, rules, stats file compilation directions, etc. 

There are 3 tabs on the setting screen.  The first is the Home Team screen, and 

sets/displays the active team’s game preferences 

 

In the image above, you can see that the Jacksonville Grits are the active team, 

their roster size is set to 25 active players, they will not use the DH rule during 

their games, and they will use the Pitch Count system for pitcher fatigue. 

When you are satisfied with your selections, click the Save button near the top-

right of the panel. 

  



The second tab allows you to “farm out” the settings made on the first tab to all 

or some of the other teams in the league. 

 

The third tab holds some personal settings, such as whether or not to compile a 

game immediately after it is played, whether to display fielder information, etc. 

 



The following is a brief explanation of each option above: 

 Compile Stats Immediately After Game.  If left unselected, the stats file will 

not be compiled and will retain its ".XGS" (XML Game Stats) extension.  If 

selected, the stats will be compiled immediately following a game (takes 

about 10 seconds) and the stats file will receive an ".XGC" (XML Game 

Compiled) extension. 

 Delete Stats File After Compiling.  This option will immediately delete the 

stats file after it has been compiled.  This will completely delete any 

permanent record of the original game, and is therefore not recommended. 

 Use AutoPlace for fielders.  When selected, this option will automatically 

place fielders based upon the pull ratings of the hitter. 

 Automatically Hold Runner at First.  If selected, any time a runner reaches 

first base, he will be automatically held. 

 Display First Names of Batters.  When a player is up to bat, his first and last 

name will appear in the batter's box if this option is selected.  If not, only 

his last name will appear. 

 Display Fielder Text Box.  If selected, a small box will pop up next to a 

fielder when the ball is hit to him, displaying his name and ratings.  If not 

selected, the pop-up box will not appear. 

 Display Pitcher Text Box.  If selected, a small box will be displayed near the 

bottom of the field displaying the pitcher's name and his pitch selections.  If 

not selected, the pop-up box will not appear.  You can control whether to 

place the box on the right or left-hand side of the field. 

 Use Schedule Lineups When Possible.  Games on an actual schedule 

normally have their starting pitchers and lineups recorded in the player file, 

and these can be automatically used during replay action.  If an originally-

scheduled game was NOT played, for whatever reason, the lineups and 

pitchers will not be recorded and will need to be set automatically.  For 

example, if a game originally scheduled was rained out, its lineups and 

pitchers will not be available.  This option has other related options, such as 

whether to use the program’s injury system, whether to have weather-

outs, etc. 



 

The fourth tab allows you to permanently adjust the play-by-play settings, such as 

font, delay, and whether to highlight player names. 

  



Medical 

This screen displays each player on the selected team, along with a checkbox 

indicating whether to rest (checked) or not rest (unchecked) him. 

 

You can automatically select or de-select all the players on the team using the 

appropriate buttons on the toolbar. 

If you wish, all teams in the league may be rested simultaneously.  This is also 

done when the stats file is reset in the Stats screen. 

  



Schedule Editor 

Altering the schedule can be done from the opening screen or from the schedule 

editor.  This is where games are scheduled, cancelled, box scores can be quickly 

analyzed, and scores for a specific date can be viewed. 

 

 To schedule a game, select the date you'd like to play from the 

calendar.  Select a visitor by selecting the team from the team list and 

clicking the "Vis" button.  Repeat for the home team with the "Home" 



button.  Then click the Save button, and the game will appear in the 

schedule list beneath the calendar. 

 To "Clone" a game (create the same matchup for the next day on the 

calendar) simply select it in the schedule list and click the "Clone" button.   

 To Delete a game from the schedule, select it in schedule list and click 

the "Delete" button. 

Games that have been previously played and stats files compiled will display the 

score in the schedule list.  Games that have not yet been played will appear with a 

check mark in the schedule list.   

Due to the nature of the checklist control, it may occasionally be necessary to re-

check a game in the schedule list. 

Two buttons beneath the schedule list are "Set Jump Date" and "Set Open 

Calendar Date".  Because of size constraints, the entire caption for the two 

buttons may not appear, as you can see in the previous picture.  Holding the 

mouse cursor over ANY button in 4th Street Baseball will display its function via a 

tooltip.   

A "Jump Date" is a date to which you can automatically jump to, simply by clicking 

the "Jump" button.  This is a convenient way to have the schedule move ahead to 

where you left off playing. 

You may also set a date to move to automatically when the player file is initially 

loaded.  This is achieved by setting the "Set Open Calendar Date." 

The actual schedule editor is set up in a similar fashion, but has a few extra 

options available, including a “Play Through” button for schedule play, and a 

menu item which allows schedules to be imported. 



 

Schedule Editor 

  

  



Playing a Game 

There are two different types of games in 4th Street Computer Baseball;  

"Scheduled" and "Unscheduled." 

A "Scheduled" game is one that has been written to the official league schedule 

via the instructions outlined above.  These games contain a special identification 

code which ties it to the schedule, permanently.  The game score will be visible in 

the schedule list, and the game's stats will be included in the Stats module. 

An "Unscheduled" game also has an identification code, but will not be tied to the 

schedule in any way.  An unscheduled game's stats will be compiled after 

completion of a game, if that is the setting you selected.  You can think of an 

unscheduled game as being sort of an "exhibition" game, except the stats count 

and the game will count in the standings unless you turn off the automatic 

compile option. 

To play a "Scheduled" game, just select it from the schedule list (it must be 

checked in order to be played) and click the "Ready" button. 

To play an "Unscheduled" game, select the visiting and home teams, then click 

the "Ready" button. 

In either case, you'll be brought to the Game Options screen, where you'll set 

both team's lineups and starting pitchers.  You can also make changes to the same 

settings available in the Settings screen. 

If lineups and starting pitchers are available for the game you've chosen, and 

you've selected the "Use Schedule Lineups When Possible" option explained 

earlier, the program will automatically populate the lineups and pitcher slots for 

you, with a few exceptions: 

 if a player is not currently on a team's roster, his slot will be left blank. 

 if a player is injured, his slot will be left blank. 



If a player's active status is "inactive," but he currently is on a team's roster, he 

will be made active and another player of the same position will be made inactive 

for the game.  This condition will continue for those players until changed. 

If no lineups or starting pitchers were designated for a game, such as in a draft 

league, then lineups and starters will need to be selected, as is the case shown 

below. 

 

Setting lineups is simplified by creating "Preset Lineups" from the Lineups screen.  

They can be accessed again from the "Preset Lineups" dropdown.   

While filling a lineup, be sure to pick the position for each player.   

You can switch between teams by switching between the "Visitor Roster/Lineups" 

and "Home Roster/Lineups" tabs. 

A "Rotations" tab helps you keep track of which pitchers are fatigued, and gives 

information about whose turn it is in the rotation. 

 



 

Under the "Fatigue" column, a green shade indicates that a pitcher is fully rested. 

Yellow indicates that a pitcher is fatigued, but not critically, and can be used, but 

not without cost, as his current fatigue value will be added to the "Season 

Fatigue" total.  Once a pitcher attains 100 "Season Fatigue" points, he will 

automatically be placed on the disabled list.  

A pitcher shaded red is fatigued, and should not be used.  Red may also be seen in 

the "Active" column if a pitcher is injured, as is the case with the left-hander 

O’Dell in the picture above...his injury designation, "G10," indicates that he will be 

out for another 10 games. 

 

 



 

There are four play options available for playing a game: 

 Normal.  This option lets you play Human vs. Human, AI vs. AI, or Human vs. 

AI.  It will automatically input the result codes during game play so you 

don’t have to. 

 Helper.  This version of the game is played in the same manner as the board 

game, with you providing the result codes, and even having the opportunity 

to input dice rolls, manually. 

 Auto-Play.  A “quick-play” version of the game controlled by AI coaches. 

 Run Schedule.  Also a “quick-play” version of the game which plays 

scheduled games automatically through the “Play Through” date set on the 

schedule editor. 

When you have filled both teams’ lineups, click the "OK" button to begin the 

game.  Depending upon which play option above you selected, the following 

descriptions may or may not be what you see on the screen. 

  



 

After the game screen loads, some weather information will be provided in the 

play-by-play area near the bottom middle of the screen.  Some corresponding 

icons will also appear on the right side of the scoreboard.  If you’re not sure what 

each icon represents, hover the mouse over them for more details. 

At the left side of the game screen is the visiting team command center, complete 

with a bench area in the form of a list, labels for the starting nine, a pitcher 

information section, and a bullpen 

list which displays each pitcher not 

currently in the lineup.  The home 

team’s command center is identical, 

and is located on the right side of the 

screen. 

Because the home team will in the 

field first, the fielder positioning 

buttons also appear on the right side 

of the screen.  Each fielder has his 

own positioning button, along with a 

corresponding label detailing his 



current position by lane and depth.  Although pitchers and catchers (and 

designated hitters, if in the game) also have a positioning button, it is disabled. 

The field shows the home team’s ballpark configuration and the current position 

of each fielder on the defense. 

 

Next to the play-by-play area is “action area” where buttons and various list boxes 

will pop up, allowing you to make game-time decisions and control the action.  In 

the picture above, a “Begin Game” button is visible.  Clicking it will initiate the 

start of the game. 

 

Once the “Begin Game” button is clicked, action will commence.  The first player 

in the visiting team’s lineup will be highlighted in green, and the first player in the 

home team’s lineup will be highlighted red.  Notice that a small indicator arrow 

will also appear to the left of each of these players.   



At this time, green arrow buttons, labeled “1” through “9,” become enabled for 

each team, allowing substitutions to be made.  To make a substitution, simply 

select a player you’d like to enter the game, and click on the arrow of the player 

you’d like to have him substitute in for.  You’ll also need to announce the position 

you want the new player to play by selecting it from the dropdown next to his 

name. 

A “Get Count” button now appears on the action area.  Click it, and the “action 

count” will be derived and displayed automatically. 

If you are unfamiliar as to how 4th Street Baseball is played, an “action count” is 

set during each at-bat.  This gives the hitter and/or pitcher an advantage during 

the at bat, and also influences the strategy decisions, such as stealing and 

bunting, that you, the manager, can make.  For example, it is usually not 

beneficial to your team to call for a steal with two outs and two strikes on the 

batter, as you are instructing him to take a pitch which may very well be strike 

three! 

 

The scoreboard “lights up” after the count has been determined, showing not 

only the count but the dice roll that determined it.  If you’d like to follow along 

with how the count was derived, double-click on the appropriate player’s (in this 

case, the pitcher) name to see a replica of his card. 

 



The program will now give the options available in the form of a list box, 

appearing where the “Get Count” button previously was located.  In this case, we 

have Tony Kubek facing Dick Ellsworth with an 0-1 count.  Kubek can “guess” Fast 

Ball, Breaking Ball, or the computer can “guess” a Random Pitch for him (actually, 

the program will take into consideration the count, the pitcher’s abilities to throw 

fast balls and breaking balls, and then make a “decision” based on the situation).  

Double-click on the selection you’d like, and the program will move on to the next 

decision. 

A Cancel option is also present, in case you forgot to make a lineup change.  

Immediately after, you’ll see the “Get Count” button appear again, but the count 

will remain the same (in this case, 0-1). 

 

The defensive team now reveals their strategy, which in this case includes 

selecting a Random Pitch to throw (a process similar to the one outlined for the 

hitter’s “guess”), throw a Fast Ball, a Breaking Ball, or Intentionally Walk the 

batter. 

 

A “Roll Dice” button appears after both teams have made their strategic 

selections.  Click the button, and the program will begin determining the result of 

the play. 



 

In this situation, a matchup between the hitter and pitcher has the pitcher, 

Ellsworth, winning.  A list of Result Numbers is posted in the action area, from 

which the user selects the correct result by referring to the dice roll and double-

clicking the appropriate result number.  The result numbers for the column in 

question, beginning with dice roll “2” and ending with dice roll “12,” is displayed.  

For the play above, a d6 roll of “5” (2 + 3 on the red 6-sided dice) was rolled, and 

result number “43” is the code to select. 

Further investigation reveals where the codes listed in the picture were derived.  

By double-clicking on Ellsworth’s name on the screen, his card is revealed, as 

shown below: 



 

The area highlighted above is the source of the 2-12 dice roll codes displayed in 

the action area.  A close-up of the action area: 

 

shows that Ellsworth threw a Fast Ball (a red “F” appears, indicating that Kubek 

“guessed” incorrectly…otherwise the label would be green). 

If the mouse is hovered over a specific result code, the dice roll it represents 

appears as a tooltip, as shown below: 

 

 

 

 



Selecting any result number other than the one designated by the dice roll will be 

ignored, even if it is identical to the one representing the dice roll. 

In this case, a “43” is a strikeout.  A full map of the result numbers can be 

accessed by clicking the green “RN” button on the toolbar. 

 

The result of the play now appears in the play-by-play area, and a “Reset” button 

appears, which locks the result into the game stat file and moves to the next 

batter in the lineup. 

 

As you can see below, Kubek has returned to the bench and Gene Woodling is 

now the batter. 

 

If runners are on base, several options are added to each team’s strategy lists, 

including bunting, stealing, squeeze plays, hit & runs, pitchouts, charging corner 

infielders, etc. 

Positioning players is handled by either selecting the “Auto-Positioning” options 

explained earlier in this document, or by manually adjusting them using the 

positioning buttons. 



Clicking on the arrow in which you 

want a fielder to move will relocate 

him by 1 lane or depth in the 

direction you choose.  The arrows 

will change to red, indicating that the 

player is shaded to a particular 

location.  Fielders who are playing 

“even” will have the dot in the 

middle of their arrow set turn red 

instead. 

Two “position all” buttons reside 

above the rest.  The “Position All 

Infielders” button is on the left and 

the “Position All Outfielders” is on the right. 

The label immediately to the right of the positioning buttons indicates the lane 

and depth in which a player is located. 

To play an infielder “in,” move him to 

depth 1 on the field.  You can do this 

with all the infielders at once using 

the “Position All Infielders” button, or 

one at a time. 

 

 

 

 



 

The game’s box score and/or log can be viewed by clicking the “Stats” button on 

the toolbar, and if a pitching move needs to be made, you can view each team’s 

pitching roster by clicking the “Rotation” button. 

 

  



Notes: 

During the making of this game, an opportunity arose to fine-tune many of the 

algorithms used in player-creation.  For that reason, each season released before 

2017 will include TWO season files.  One includes the original player ratings that 

were present on printed cards to that point in time.  The other, designated with a  

“v2” before the “.X4BB” extension (for example, “BB2016v2.X4BB”) in its player 

files, is an updated version of the player ratings which will be the standard going 

forward.  Version 2 player cards will be released beginning with the 2017 season 

in February, 2018, for all seasons, and the older version cards will be retired. 

Video helper files have been placed on the support page, 

https://www.4thstreetsoftware.com/serv03.htm, for your convenience. 

  

https://www.4thstreetsoftware.com/serv03.htm
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